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FEATURES 

Fully featured Arduino shield for the ADT7410, ADT7420, 

ADT7310, and ADT7320 

PC control in conjunction with the Arduino IDE 

EVALUATION KIT CONTENTS 

EV-TEMPSENSE-ARDZ kit 

EVAL-ADT7420ARDZ evaluation board (shield) 

EVAL-ADT7420MBZ remote evaluation board 

EVAL-ADT7320MBZ remote evaluation board 

2 plastic screws and washers 

6-way and 4-way ribbon cables 

EQUIPMENT NEEDED 

Arduino or Linduino development board 

USB cable (A type end to B type end)  

PC or laptop running Windows® 10 operating system 

SOFTWARE NEEDED 

LTSketchbook 

ADT7420 No-OS driver 

Arduino IDE 

ONLINE RESOURCES 

Evaluation board schematics and bill of materials 

GENERAL DESCRIPTION 

The ADT7410, ADT7420, ADT7310, and ADT7320 are high 

accuracy digital temperature sensors offering breakthrough 

performance over a wide industrial temperature range. The 

devices contain an internal band gap reference, a temperature 

sensor, and a 16-bit analog-to-digital converter (ADC) to 

monitor and digitize the temperature to 0.0078°C resolution. 

The devices are available in I2C or SPI versions. 

The EV-TEMPSENSE-ARDZ is an evaluation board kit that 

allows easy evaluation of the ADT7410, ADT7420, ADT7310, 

and ADT7320 precision digital temperature sensors. Users can 

interface to these sensors on the Arduino evaluation board 

(shield), or with the ribbon cable connected to the external 

sensors. Consult the ADT7410, ADT7420, ADT7310, and 

ADT7320 data sheets in conjunction with this user guide when 

using the EV-TEMPSENSE-ARDZ with the Arduino integrated 

development environment (IDE). 
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Figure 1.  
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EVALUATION BOARD HARDWARE 
HARDWARE SETUP 

The EV-TEMPSENSE-ARDZ development kit contains the 

following boards (see Figure 2 to Figure 4): 

 The EVAL-ADT7420ARDZ shield

 The EVAL-ADT7420MBZ remote evaluation board

 The EVAL-ADT7320MBZ remote evaluation board

Place the EVAL-ADT7420ARDZ shield on top of the Arduino™ 

development board by matching up the EVAL-ADT7420ARDZ 

shield power with the P4, P5, P6, and P7 analog and digital 

connectors (see Figure 5). 

Connect the 4-way ribbon cable and the external EVAL-

ADT7420MBZ printed circuit board (PCB) to  

Connector P1 on the EVAL-ADT7420ARDZ shield. 

Connect the 6-way ribbon cable and the external EVAL-

ADT7320MBZ PCB to Connector P2 on the EVAL-

ADT7420ARDZ shield. 

See Figure 5 for a connection diagram of all of the boards. 

LOCATION OF EVALUATION BOARD SCHEMATICS 

The evaluation board schematic diagrams and bill of materials 

are included with all the supporting documentation on the EV-

TEMPSENSE-ARDZ product page. 

POWER SUPPLIES 

The EVAL-ADT7420ARDZ shield is powered by the 5 V power 

supply from the Arduino development board and this power 

supply is regulated to either 3.0 V or 3.3 V, selected by the 

EVAL-ADT7420ARDZ, JP1. The default setting of the power 

supply is 3.0 V. Alternatively, the EVAL-ADT7420ARDZ shield 

can be powered externally via P10, which is selected by 

changing the JP2 jumper Position B. 

The EVAL-ADT7420MBZ and the EVAL-ADT7430MBZ 

evaluation boards are powered with the same 5 V power supply, 

but are selected by P1 and P2, respectively. 
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Figure 2. EVAL-ADT7420ARDZ Evaluation Board 
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Figure 3. EVAL-ADT7420MBZ Evaluation Board 
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Figure 4. EVAL-ADT7320MBZ Evaluation Board 
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Figure 5. Hardware Connected Diagram 
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INSTALLING THE ARDUINO IDE 

Download the latest version of the Arduino software from the 

Arduino IDE link located under the Setup section from the 

www.analog.com/en/design-center/evaluation-hardware-and-

software/linduino site. For more information on how to install 

the Arduino IDE, visit the Arduino home page. 

INSTALLING THE LTSKETCHBOOK 

To install and set up the LTSketchbook, take the following steps: 

1. If using the Linduino hardware for the first time, visit the 

Linduino page at www.analog.com/en/design-center/ 

evaluation-hardware-and-software/linduino.html for 

instructions on how to install the LTSketchbook. 

2. Download the latest Linduino sketchbook, 

LTSketchbook.zip, from www.analog.com/media/en/ 

engineering-tools/design-tools/LTSketchbook.zip. This zip 

file contains the entire code base for the Linduino board, 

which includes all demo code, libraries for individual 

devices, and auxiliary functions. 

3. Extract this zip file (right click the file) to a location for 

working files, such as the Documents folder. 

4. To change the Arduino IDE settings to use the LTSketchbook, 

open the Arduino IDE software and navigate to File > 

Preferences, which opens the window shown in Figure 6. 
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Figure 6. Arduino IDE Preferences Window 

5. In the Sketchbook location field shown in Figure 6, 

click Browse and locate the path to the extracted 

LTSketchbook.zip file. The correct file location is shown in 

the LTSketchbook option in the Look in dropdown menu 

and the following seven subdirectories are shown: Active 

Learning, Documentation, Example Designs, libraries, 

Part Number, User Contributed, and Utilities (see Figure 7). 

21
65

8-
00

6

 

Figure 7. LTSketchbook Location 

6. Note that changing the LTSketchbook location affects how 

the built in compiler reads the libraries saved on the default 

Arduino/libraries folder. This folder is automatically created 

after installing the Arduino. 

ADT7420 NO OPERATING SYSTEM (NO-OS) DRIVER 

Download the adt720.h and adt7420.c files, required to operate 

the No-OS driver, from the Analog Devices, Inc., GitHub 

repository, as shown in Figure 8. Go to www.github.com/ 

analogdevicesinc/no-OS to download the files. 

The No-OS driver path is no-OS/drivers/temperature/adt7420/ 

(see Figure 8). 
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Figure 8. Analog GitHub Repository 

In the LTSketchbook/libraries folder automatically created 

after Step 3 in the Installing the LTSketchbook section (see 

Figure 7), create a new folder and name it adt7420. Copy and 

paste the adt7420.h and adt7420.c files into the newly created 

adt7420 folder, as shown in Figure 9. 
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Figure 9. Documents/Arduino/LTSketchbook/libraries/adt7420 Folder 
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LOAD EXAMPLE SKETCH 

After downloading and placing all files in the correct location, 

take the following steps to load an example sketch from the 

LTSketchbook: 

1. Close and open a new Arduino IDE. In the Arduino IDE, 

navigate to File > Sketchbook > LTSketchbook > Part 

Number > ADI-Parts > EVAL-ADT7420 (see Figure 10). A 

new window opens with the EVAL-ADT7420ARDZ 

example software. This software allows the user to use the 

EVAL-ADT7420ARDZ shield with the Arduino board. 
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Figure 10. Arduino IDE Load Sketch Example 

2. Plug the Arduino board to the PC via the USB cable. Select 

the board type and serial port by navigating to Tools > 

Port and select the serial device of the board as shown in 

Figure 11. 
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Figure 11. Arduino IDE Communications Port 

3. Upload the sketch from Step 1 to the Arduino board by 

clicking the right pointing arrow button shown in Figure 12. 
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Figure 12. Arduino IDE Upload Sketch 

 

 

 

 

4. When the uploading process is completed, a message at the 

bottom of the IDE displays the message in Figure 13. 
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Figure 13. Arduino IDE Upload Success 

5. Open the serial monitor by navigating to Tools > Serial 

Monitor (see Figure 11 for the Tools dropdown list). Select 

Newline for the dropdown list circled in red in Figure 14 

and set the baud rate to 115200. To use the serial monitor, 

enter the commands in Figure 14 in the text box at the top 

of the window and click Send. 
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Figure 14. Arduino IDE Serial Monitor 

USING AN EXTERNAL ADT7420 

To select the remote ADT7420, close the serial monitor and 

change the device address to 0x49 in the sketch example (see 

Figure 15). Verify and upload the sketch to the Arduino board, 

then wait until the code finishes uploading and the message in 

Figure 13 is shown. Next, open the serial monitor. 
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Figure 15. Arduino IDE Code Change 

Note that the ADT7310, ADT7320, and ADT7410 can also be 

selected, but this example sketch only considers the ADT7420 

and users must modify the code shown in Figure 15 

accordingly. 
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NOTES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I2C refers to a communications protocol originally developed by Philips Semiconductors (now NXP Semiconductors). 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written 
notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, 
RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF 
INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S 
POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES 
SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will 
comply with all applicable United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the 
Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and 
Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is 
expressly disclaimed. 

©2019 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
  UG21658-0-10/19(0)  
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